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See the following sections:

• About Calendar Integrations in Cisco Unity Connection 8.0, page 34-1

• About Contact Integrations in Cisco Unity Connection 8.0, page 34-2

• Creating a Calendar and Contact Integration with Exchange 2007 in Cisco Unity Connection 8.0, 
page 34-2

• Creating a Calendar and Contact Integration with Exchange 2003 in Cisco Unity Connection 8.0, 
page 34-9

• Creating a Calendar and Contact Integration with Cisco Unified MeetingPlace in Cisco Unity 
Connection 8.0, page 34-16

• Creating a Calendar Integration with Cisco Unified MeetingPlace Express in Cisco Unity 
Connection 8.0, page 34-21

For information on configuring calendar and contact integrations in Cisco Unity Connection 8.5 and 
later, see the “Configuring Cisco Unity Connection 8.5 and Later and Microsoft Exchange for Unified 
Messaging” chapter and/or the “Configuring Cisco Unity Connection 8.5 and Later and Cisco Unified 
MeetingPlace for Unified Messaging” chapter of the Unified Messaging Guide for Cisco Unity 
Connection Release 8.5 and Later, available at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/unified_messaging/guide/85xcucum
gx.html.

About Calendar Integrations in Cisco Unity Connection 8.0
When integrated with supported calendar applications (Exchange 2007, Exchange 2003, Cisco Unified 
MeetingPlace, or Cisco Unified MeetingPlace Express), Cisco Unity Connection enables users to do the 
following by phone:

• Hear a list of upcoming meetings (Outlook meetings only).

• Join a meeting that is in progress (MeetingPlace and MeetingPlace Express meetings only).

• Hear a list of the participants for a meeting.

• Send a message to the meeting organizer.

• Send a message to the meeting participants.
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• Accept or decline meeting invitations (Outlook meetings only).

• Set up immediate meetings (MeetingPlace and MeetingPlace Express meetings only).

• Cancel a meeting (meeting organizers only).

About Contact Integrations in Cisco Unity Connection 8.0
When integrated with Exchange 2007 or Exchange 2003, Cisco Unity Connection enables users to 
import Exchange contacts by using the Connection Messaging Assistant web tool. The contact 
information can then be used in rules that users create in the Cisco Unity Connection Personal Call 
Transfer Rules web tool and when users place outgoing calls by using voice commands.

Creating a Calendar and Contact Integration with Exchange 2007 
in Cisco Unity Connection 8.0

If you have Exchange 2007 installed, you can integrate Cisco Unity Connection with Exchange 2007 so 
that users can do the following:

• Review upcoming meetings by phone.

• Import Exchange contacts. The contact information can be used in rules that users create in the 
Personal Call Transfer Rules web tool and when users place outgoing calls by using voice 
commands.

For information on configuring calendar and contact integrations in Cisco Unity Connection 8.5 and 
later, see the “Configuring Cisco Unity Connection 8.5 and Later and Microsoft Exchange for Unified 
Messaging” chapter and/or the “Configuring Cisco Unity Connection 8.5 and Later and Cisco Unified 
MeetingPlace for Unified Messaging” chapter of the Unified Messaging Guide for Cisco Unity 
Connection Release 8.5 and Later, available at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/unified_messaging/guide/85xcucum
gx.html.

Task List for Creating a Calendar and Contact Integration with Exchange 2007 
in Cisco Unity Connection 8.0

1. Review the system requirements to confirm that all requirements for Exchange 2007 and the 
Cisco Unity Connection server have been met. See the “Requirements for the Exchange 2007 
Calendar and Contact Integration in Cisco Unity Connection 8.0” section on page 34-3.

2. Configure Exchange 2007. See the “Configuring Exchange 2007 for the Calendar and Contact 
Integration in Cisco Unity Connection 8.0” section on page 34-3.

3. Configure Connection. See the “Configuring Cisco Unity Connection 8.0 for the Exchange 2007 
Calendar and Contact Integration” section on page 34-6.

4. (When enabling personal call transfer rules only) Verify that the users or templates are assigned to 
a class of service that enables them to use the personal call transfer rules feature.

5. Configure the Connection users. See the “Configuring Users for the Exchange 2007 Calendar and 
Contact Integration in Cisco Unity Connection 8.0” section on page 34-7.
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6. Test the calendar integration. See the “Testing the Exchange 2007 Calendar Integration in 
Cisco Unity Connection 8.0” section on page 34-8.

7. To teach users how to use the Connection calendar, refer them to the following:

• For listing, joining, and scheduling meetings, see the “Cisco Unity Connection Phone Menus and 
Voice Commands” chapter of the User Guide for the Cisco Unity Connection Phone Interface 
(Release 8.x) at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/user/guide/phone/b_8xcucugpho
ne.html.

• For importing Exchange contacts, see the “Managing Your Personal Contacts” chapter of the User 
Guide for the Cisco Unity Connection Messaging Assistant Web Tool (Release 8.x) at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/user/guide/assistant/b_8xcucuga
sst.html.

• For using personal call transfer rules, see the User Guide for the Cisco Unity Connection Personal 
Call Transfer Rules Web Tool (Release 8.x) at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/user/guide/pctr/b_8xcucugpctr.h
tml.

Requirements for the Exchange 2007 Calendar and Contact Integration in 
Cisco Unity Connection 8.0

The calendar and contact integration with Exchange 2007 has the following requirements:

• Exchange 2007 as described in the “Requirements for Accessing Calendar Information for 
Meetings” and “Requirements for Accessing Exchange Contact Information” sections of System 
Requirements for Cisco Unity Connection Release 8.x at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/requirements/8xcucsysreqs.html
. 

• Cisco Unity Connection installed as described in the Installation Guide for Cisco Unity Connection 
Release 8.x at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/installation/guide/8xcucigx.html
.

Configuring Exchange 2007 for the Calendar and Contact Integration in 
Cisco Unity Connection 8.0

Revised November 16, 2010
Do the following tasks to configure Exchange 2007 for the calendar and contact integration:

1. Confirm that the Exchange 2007 server has been configured to include the “Client Access” role.

2. Do the “To Configure Access to Exchange 2007 for the Calendar and Contact Integration in 
Cisco Unity Connection 8.0” procedure on page 34-4.

3. (Optional) If you are using SSL for secure access to the Exchange 2007 server, do the “To Configure 
Secure Access to Exchange 2007 for the Calendar and Contact Integration (With SSL) in 
Cisco Unity Connection 8.0” procedure on page 34-5.
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To Configure Access to Exchange 2007 for the Calendar and Contact Integration in Cisco Unity Connection 8.0

Step 1 On the Exchange server, open the Internet Services (IIS) Manager application.

Step 2 Go to Internet Information Services > <server name> > Web Sites > Default Web Site.

Step 3 Right-click Exchange and select Properties.

Step 4 In the Exchange Properties dialog box, select the Virtual Directory tab.

Step 5 Under Content For This Resource Should Come From, select A Directory Located On This Computer.

Step 6 Confirm the Local Path is set to \\.\BackOfficeStorage\<your-domain.com>\MBX. 

Step 7 Select the Read check box.

Step 8 Select the Directory Security tab.

Step 9 Under Authentication and Access Control, select Edit.

Step 10 In the Authenticated Access section of the Authentication Methods dialog box, check the check boxes 
for one or more of the following options:

• Integrated Windows authentication (sometimes referred to as NTLM)

• Basic Authentication

• Digest Authentication for Windows Domain Servers

Step 11 Select OK.

Step 12 In the Exchange Properties dialog box, select OK.

Step 13 Go to Internet Information Services > <server name> > Web Service Extensions.

Step 14 In the right-hand pane, select WebDav and confirm that the status is “Allowed.” If the status is not 
“Allowed”, click Allow. 

Step 15 On the Exchange server, open the Exchange Management Console.

Step 16 Go to Server Configuration > Mailbox.

Step 17 Do the following for each mailbox that you want to configure for the calendar and contact integration:

a. In the upper middle pane, select the mailbox name. 

b. In the lower middle pane, select the WebDav tab.

c. Right-click Exchange (Default Web Site) and select Properties.

d. In the Exchange (Default Web Site) Properties dialog box, select the Authentication tab.

e. Select Use One or More Standard Authentication Methods and select the same authentication 
method(s) that you configured in Step 10. 

Step 18 Click OK.

Step 19 Open the Exchange Management Shell.

Step 20 In the Exchange Management Shell, enter the following command:

iisbreset /noforce

Step 21 Press Enter.
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To Configure Secure Access to Exchange 2007 for the Calendar and Contact Integration (With SSL) in Cisco Unity 
Connection 8.0

Note If you have already configured secure IMAP with SSL and have enabled the certificate for both 
IMAP and IIS, then you can skip the following procedure and continue with the “Configuring 
Cisco Unity Connection 8.0 for the Exchange 2007 Calendar and Contact Integration” section 
on page 34-6.

Step 1 On the Exchange Server, open the Exchange Management Shell application.

Step 2 Enter the following command, where <Exchange server> is the IP address or fully qualified domain 
name of the Exchange server and <friendly name> is the friendly name that you chose for the Exchange 
server:

• new-exchangecertificate -generaterequest -domainname <Exchange server> -friendlyname 
<friendly name>-path c:\csr.txt

Caution The domain name for the Exchange server must be the IP address or the fully qualified domain 
name (recommended) so that the Connection server can successfully ping the Exchange 
server. Otherwise, the calendar and contact integration may not function correctly.

Step 3 Press Enter.

A Certificate Signing Request (CSR) file with the name Csr.txt is created in the root directory.

Step 4 Send the CSR file to a Certification Authority (CA), which generates and sends back a new certificate.

Note You must have a copy of the CA public root certificate or public root certificate chain. This 
certificate is needed for configuring Connection to trust the Exchange 2007 server.

Step 5 Save the new certificate in a location that is accessible to the Exchange server on which you want to 
import the certificate.

Step 6 On the Exchange Server, open the Exchange Management Shell application. 

Step 7 Enter the following command, where <path> is the full path of the new certificate that you received from 
the CA:

import-exchangecertificate -path <path>

Step 8 Press Enter.

Step 9 Enter the following command:

dir cert:\localmachine\my | fl

Step 10 Press Enter.

Step 11 Highlight the “thumbprint” property and press Ctrl-C to copy it to the clipboard.

Step 12 If Connection will be configured to use IMAP to access both email and calendar data from Exchange 
2007, enter the following command, where <thumbprint> is the “thumbprint” that you copied in Step 11:

enable-exchangecertificate -thumbprint <thumbprint> -services "IIS,IMAP"

If Connection will not be configured to use IMAP but will be configured to use calendar data from 
Exchange 2007, enter the following command, where <thumbprint> is the “thumbprint” that you copied 
in Step 11:
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enable-exchangecertificate -thumbprint <thumbprint> -services "IIS"

Step 13 Press Enter.

Step 14 If you want data transmitted as clear text, skip the remaining steps in this procedure and continue with 
the “Configuring Cisco Unity Connection 8.0 for the Exchange 2007 Calendar and Contact Integration” 
section on page 34-6. Otherwise, open the IIS Manager application.

Step 15 Go to IIS > <server name> > Web Sites > Default Web Site.

Step 16 Right-click Default Web Site and select Properties.

Step 17 In the Properties dialog box, select the Directory Security tab.

Step 18 Under Secure Communications, select Edit.

Step 19 Check the Require Secure Channel check box.

Step 20 Select OK.

Step 21 In the Properties dialog box, select OK.

Configuring Cisco Unity Connection 8.0 for the Exchange 2007 Calendar and 
Contact Integration

Do the following procedure.

To Configure Cisco Unity Connection 8.0 for the Exchange 2007 Calendar and Contact Integration

Step 1 In Cisco Unity Connection Administration, expand System Settings, then select External Services.

Step 2 On the Search External Services page, select Add New.

Step 3 On the New External Service page, in the Type list, select Exchange 2007 External Service Template.

Step 4 Check the Enabled check box to enable the calendar and contact integration.

Step 5 In the Display Name field, enter a descriptive name.

Step 6 In the Server field, enter the IP address or host name for the Exchange 2007 server.

Step 7 In the Authentication Mode field, select the applicable setting to match the authentication mode that is 
used by the Exchange server.

Step 8 In the Security Transport field, select the applicable setting:

• None—Connection does not use a secure connection with the Exchange 2007 server.

• SSL—Connection uses an SSL connection with the Exchange 2007 server.

Step 9 If you selected “SSL” and you want Connection to validate the Exchange 2007 server certificate, check 
the Validate Server Certificate check box.

Self-signed certificates cannot be validated. If you selected SSL and you are using self-signed 
certificates, do not check the Validate Server Certificate check box, or Connection will not be able to 
access Exchange. 
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Caution The CN value on the server certificate subject line or the subjectAltName:dnsname field of 
the server certificate must match the setting of Server field. Otherwise, validation of the server 
certificate will fail.

The root certificate or all certificates in a root certificate chain of the Certification Authority 
(CA) that signed the server certificate must be installed as Connection-trust certificates in 
Cisco Unified Operating System Administration. Otherwise, validation of the server 
certificate will fail.

Step 10 Under Service Capabilities, check the User Access to Calendar and Personal Contacts check box.

Step 11 Select Verify. A message appears indicating whether the Cisco Unity Connection configuration has been 
successfully verified.

If the verification fails, confirm the configuration for Exchange 2007 and Cisco Unity Connection.

Step 12 Select Save.

Configuring Users for the Exchange 2007 Calendar and Contact Integration in 
Cisco Unity Connection 8.0

Do the following procedure.

Caution Exchange 2007 must have a mailbox and Active Directory must have a user account for each Connection 
user that you are configuring.

To Configure Users for the Exchange 2007 Calendar and Contact Integration in Cisco Unity Connection 8.0

Step 1 In Cisco Unity Connection Administration, expand Users, then select Users.

Step 2 On the Search Users page, select the alias of a user.

Note If the user alias does not appear in the search results table, set the applicable parameters in the 
search fields at the top of the page, and select Search.

Step 3 On the Edit User Basics page, on the Edit menu, select External Service Accounts.

Step 4 On the External Service Accounts page, select Add New.

Step 5 On the New External Service Accounts page, in the External Service field, select the display name that 
you entered in the “To Configure Cisco Unity Connection 8.0 for the Exchange 2007 Calendar and 
Contact Integration” procedure on page 34-6.

Step 6 In the Email Address field, enter the Exchange email address in Active Directory for the user.

Step 7 In the Sign-In Type field, select the applicable option:

• Use Connection Alias—This option is useful when the Active Directory domain alias for the user 
is the same as the Connection user alias. Connection signs in the user with the Connection user alias.
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• Use User ID Provided Below—(Recommended) Enter the Active Directory domain alias for the 
user (useful when the User ID setting is different from the Connection user alias). Connection signs 
in the user with the setting in this field.

Step 8 (Only when the Use User ID Provided Below option is selected in Step 7) In the User ID field, enter the 
User ID setting from Active Directory.

Step 9 If known, in the Password field, enter the Active Directory domain password for the user. Connection 
signs in the user with the setting in this field.

Note If you leave the Password field blank, users must sign in to Cisco Personal Communications 
Assistant and enter their password on the External Services Accounts page. For details, see the 
“Changing Your Cisco Unity Connection Passwords” chapter of the User Guide for the 
Cisco Unity Connection Messaging Assistant Web Tool (Release 8.x) at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/user/guide/assistant/b_8xcuc
ugasst.html.

Step 10 Under Service Capabilities, check the User Access to Calendar and Personal Contacts check box.

Note A user can have only one external service that has the User Access to Calendar and Personal 
Contacts check box or the User Access to Calendar check box checked.

Step 11 Select Save.

Step 12 To check the calendar configuration for the user, select Test. The Task Execution Results window 
appears with the test results.

If any part of the test fails, verify the configuration for Exchange 2007, Active Directory, Cisco Unity 
Connection, and the Connection user.

Step 13 Repeat Step 2 through Step 12 for all remaining users.

Testing the Exchange 2007 Calendar Integration in Cisco Unity Connection 8.0
Do the following procedure.

To Test the Configuration for the Exchange 2007 Calendar Integration in Cisco Unity Connection 8.0

Step 1 Sign in to Outlook.

Step 2 On the Go menu, select Calendar.

Step 3 On the File menu, select New > Meeting Request.

Step 4 Enter values in the required fields to schedule a new meeting for the current time, and invite a user who 
has an account on Cisco Unity Connection.

Step 5 Select Send.

Step 6 Sign in to the Cisco Unity Connection mailbox of the user that you invited to the Outlook meeting in 
Step 4.

Step 7 If the user account is configured for speech access, say Play Meetings.
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If the user account is not configured for speech access, press 6, and then follow the prompts to list 
meetings.

Connection reads the information about the Exchange 2007 meeting.

Creating a Calendar and Contact Integration with Exchange 2003 
in Cisco Unity Connection 8.0

If you have Exchange 2003 installed, you can integrate Cisco Unity Connection with Exchange 2003 so 
that users can do the following:

• Review upcoming meetings by phone or while using the Cisco Personal Communications Assistant 
(PCA).

• Import Active Directory contacts. The contact information can be used in rules that users create in 
the Personal Call Transfer Rules web tool and when users place outgoing calls by using voice 
commands.

For information on configuring calendar and contact integrations in Cisco Unity Connection 8.5 and 
later, see the “Configuring Cisco Unity Connection 8.5 and Later and Microsoft Exchange for Unified 
Messaging” chapter and/or the “Configuring Cisco Unity Connection 8.5 and Later and Cisco Unified 
MeetingPlace for Unified Messaging” chapter of the Unified Messaging Guide for Cisco Unity 
Connection Release 8.5 and Later, available at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/unified_messaging/guide/85xcucum
gx.html.

Task List for Creating a Calendar and Contact Integration with Exchange 2003 
in Cisco Unity Connection 8.0

1. Review the system requirements to confirm that all requirements for Exchange 2003 and the 
Cisco Unity Connection server have been met. See the “Requirements for the Exchange 2003 
Calendar and Contact Integration in Cisco Unity Connection 8.0” section on page 34-10.

2. Configure Exchange 2003. See the “Configuring Exchange 2003 for the Calendar and Contact 
Integration in Cisco Unity Connection 8.0” section on page 34-10.

3. Configure Connection. See the “Configuring Cisco Unity Connection 8.0 for the Exchange 2003 
Calendar and Contact Integration” section on page 34-13.

4. (When enabling personal call transfer rules only) Verify that the users or templates are associated 
with a class of service that enables them to use the personal call transfer rules feature.

5. Configure the Connection users. See the “Configuring Users for the Exchange 2003 Calendar and 
Contact Integration in Cisco Unity Connection 8.0” section on page 34-14.

6. Test the calendar integration. See the “Testing the Exchange 2003 Calendar Integration in 
Cisco Unity Connection 8.0” section on page 34-15.

7. To teach users how to use the Connection calendar, refer them to the following:
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• For listing, joining, and scheduling meetings, see the “Cisco Unity Connection Phone Menus and 
Voice Commands” chapter of the User Guide for the Cisco Unity Connection Phone Interface 
(Release 8.x) at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/user/guide/phone/b_8xcucugpho
ne.html.

• For importing Active Directory contacts, see the “Managing Your Personal Contacts” chapter of the 
User Guide for the Cisco Unity Connection Messaging Assistant Web Tool (Release 8.x) at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/user/guide/assistant/b_8xcucuga
sst.html.

• For using personal call transfer rules, see the User Guide for the Cisco Unity Connection Personal 
Call Transfer Rules Web Tool (Release 8.x) at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/user/guide/pctr/b_8xcucugpctr.h
tml.

Requirements for the Exchange 2003 Calendar and Contact Integration in 
Cisco Unity Connection 8.0

The calendar and contact integration with Exchange 2003 has the following requirements:

• Exchange 2003 as described in the “Requirements for Accessing Calendar Information for 
Meetings” and “Requirements for Accessing Exchange Contact Information” sections of System 
Requirements for Cisco Unity Connection Release 8.x at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/requirements/8xcucsysreqs.html
.

• Cisco Unity Connection installed as described in the Installation Guide for Cisco Unity Connection 
Release 8.x at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/installation/guide/8xcucigx.html
.

Configuring Exchange 2003 for the Calendar and Contact Integration in 
Cisco Unity Connection 8.0

Do the applicable procedures.

To Create the Privileged Service Account for the Exchange 2003 Calendar and Contact Integration in Cisco Unity 
Connection 8.0

Step 1 On the Domain Controller, open Active Directory Users and Computers.

Step 2 Right-click Users and select New > User.

Step 3 Create a domain user account with alias cucsvc.

Note It is not necessary to create a mailbox for this user.

Step 4 On the Exchange server, on the Windows Start menu, select Programs > Microsoft Exchange > System 
Manager.

Step 5 Under Servers, right-click the server name and select Properties.
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Step 6 In the Properties dialog box, select the Security tab.

Step 7 Select Add and add cucsvc (the alias for the domain account that you created in Step 3) to the list of 
accounts with permissions on the store.

Step 8 Select Check Names.

Step 9 Select OK.

Step 10 In the list, select cucsvc (the alias for the domain account that you created in Step 3).

Step 11 Set the permissions for the domain account alias to allow for Receive As, Send As, and Administer 
Information Store. Deny all other permissions.

Step 12 In the Properties dialog box, select OK.

If you are not using SSL for access to the Exchange 2003 server, do the “To Configure Basic Access to 
Exchange 2003 for the Calendar and Contact Integration (Without SSL) in Cisco Unity Connection 8.0” 
procedure on page 34-11.

If you are using SSL for secure access to the Exchange 2003 server, do the “To Configure Secure Access 
to Exchange 2003 for the Calendar and Contact Integration (With SSL) in Cisco Unity Connection 8.0” 
procedure on page 34-12.

To Configure Basic Access to Exchange 2003 for the Calendar and Contact Integration (Without SSL) in Cisco Unity 
Connection 8.0

Step 1 On the Domain Controller, go to Active Directory Users and Computers.

Step 2 Under Users, select all user accounts that have calendars that you want Connection to access.

Step 3 Right-click the highlighted users and select Exchange Tasks.

Step 4 In the Exchange Tasks dialog box, select Configure Exchange Features.

Step 5 Under Protocols, select Outlook Web Access.

Step 6 Select the Enable icon.

Step 7 Select Next.

Step 8 Select Finish.

Step 9 On the Exchange server, open the Exchange System Manager application.

Step 10 Go to Servers > <server name> > Protocols > HTTP > Exchange Virtual Server.

Step 11 Select the Settings tab.

Step 12 Confirm that the Enable Forms Based Authentication check box is unchecked.

Step 13 Select OK.

Step 14 Go to Servers > <server name> > Protocols > HTTP > Exchange Virtual Server > Exchange.

Step 15 Right-click Exchange and select Properties.

Step 16 In the Properties dialog box, select the Access tab.

Step 17 Confirm that the following check boxes are checked:

• Read

• Write

• Directory Browsing
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Step 18 Select Authentication.

Step 19 Confirm that one or more of the following options are enabled:

• Basic

• Digest

• Integrated Windows Authentication

Step 20 Select OK.

Step 21 In the Properties dialog box, select OK.

Step 22 Open the IIS Manager application.

Step 23 Go to IIS > <server name> > Web Sites > Default Web Site.

Step 24 Right-click Default Web Site and select Properties.

Step 25 In the Properties dialog box, select the Directory Security tab.

Step 26 Under Authentication and Access Control, select Edit.

Step 27 Confirm that the enabled authentication schemes match those that you enabled in Step 19.

Step 28 Select OK.

Step 29 In the Properties dialog box, select OK.

To Configure Secure Access to Exchange 2003 for the Calendar and Contact Integration (With SSL) in Cisco Unity 
Connection 8.0

Step 1 On the Exchange server, open the IIS Manager application.

Step 2 Go to IIS > Web Sites > Default Web Site.

Step 3 Right-click Default Web Site and select Properties.

Step 4 In the Properties dialog box, select the Directory Security tab.

Step 5 Under Secure Communications, select Server Certificate.

Step 6 Select Next.

Step 7 Select Create a New Certificate.

Note If this option is not available, you must remove the existing certificate and do this step again.

Step 8 Select Prepare the Request Now, But Send It Later.

Step 9 Follow the prompts in the wizard to enter the applicable information for your organization.

Caution The “common name” for the Exchange server certificate must be the IP address or the fully 
qualified DNS name (recommended) of the Exchange server. Otherwise, the calendar and 
contact integration may not function correctly.

Step 10 Save the Certificate Signing Request (CSR) as a file.

Step 11 Send the CSR file to a Certification Authority (CA), which generates and sends back a new certificate.
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Note You must have a copy of the CA public root certificate or public root certificate chain. This 
certificate is needed for configuring Connection to trust the Exchange 2003 server.

Step 12 Return to the IIS Manager application.

Step 13 Go to IIS > Web Sites > Default Web Site.

Step 14 Right-click Default Web Site and select Properties.

Step 15 In the Properties dialog box, select the Directory Security tab.

Step 16 Under Secure Communications, select Server Certificate.

Step 17 Select Next.

Step 18 Select Process the Pending Request and Install the Certificate and select Next.

Step 19 Browse to the local file system and select the new certificate that CA sent.

Step 20 Select Next.

Step 21 Confirm that the certificate information is valid and select Next.

Step 22 Select Finish.

Step 23 In the Properties dialog box, select OK.

Step 24 Return to the IIS Manager application.

Step 25 Go to IIS > <sever name> > Web Sites > Default Web Site.

Step 26 Right-click Default Web Site and select Properties.

Step 27 In the Properties dialog box, select the Directory Security tab.

Step 28 Under Secure Communications, select Edit.

Step 29 Check the Require Secure Channel check box.

Step 30 Select OK.

Step 31 In the Properties dialog box, select OK.

Configuring Cisco Unity Connection 8.0 for the Exchange 2003 Calendar and 
Contact Integration

Do the following procedure.

To Configure Cisco Unity Connection 8.0 for the Exchange 2003 Calendar and Contact Integration

Step 1 In Cisco Unity Connection Administration, expand System Settings, then select External Services.

Step 2 On the Search External Services page, select Add New.

Step 3 On the New External Service page, in the Type list, select Exchange 2003 External Service Template.

Step 4 Check the Enabled check box to enable the external service.

When this check box is not checked, the integration with Exchange 2003 is disabled.

Step 5 In the Display Name field, enter a descriptive name.
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Step 6 In the Server field, enter the IP address or host name for the Exchange 2003 server.

Step 7 In the Authentication Mode field, select the applicable setting to match the authentication mode that is 
used by the Exchange server.

Step 8 In the Security Transport field, select the applicable setting:

• None—Connection does not use a secure connection with the Exchange 2003 server.

• SSL—Connection uses an SSL connection with the Exchange 2003 server.

Step 9 If you selected “SSL” and you want Connection to validate the Exchange 2003 server certificate, check 
the Validate Server Certificate check box.

Self-signed certificates cannot be validated. If you selected SSL and you are using self-signed 
certificates, do not check the Validate Server Certificate check box, or Connection will not be able to 
access Exchange. 

Caution The CN value on the server certificate subject line or the subjectAltName:dnsname field of 
the server certificate must match the setting of Server field. Otherwise, validation of the server 
certificate will fail.

The root certificate or all certificates in a root certificate chain of the Certification Authority 
(CA) that signed the server certificate must be installed as Connection-trust certificates in 
Cisco Unified Operating System Administration. Otherwise, validation of the server 
certificate will fail.

Step 10 In the Alias field, enter the Windows domain and alias for the privileged service account that Connection 
uses to sign in to the Exchange 2003 server. (For example, enter “doman\alias”).

This setting must match the user ID for the privileged service account that is configured in Exchange 
2003.

Step 11 In the Password field, enter the password for the privileged service account that Connection uses to sign 
in to the Exchange 2003 server.

This setting must match the user password for the privileged service account that is configured in 
Exchange 2003.

Step 12 Under Service Capabilities, check the User Access to Calendar and Personal Contacts check box.

Step 13 Select Save.

Step 14 To check the integration with Exchange 2003, select Test. The Task Execution Results window appears 
with the test results.

If any part of the test fails, verify the configuration for Exchange 2003 and Cisco Unity Connection.

Configuring Users for the Exchange 2003 Calendar and Contact Integration in 
Cisco Unity Connection 8.0

Do the following procedure.

Note Exchange 2003 must have a mailbox and Active Directory must have a user for each Connection user 
that you are configuring.
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To Configure Users for the Exchange 2003 Calendar and Contact Integration in Cisco Unity Connection 8.0

Step 1 In Cisco Unity Connection Administration, expand Users, then select Users.

Step 2 On the Search Users page, select the alias of a user.

Note If the user alias does not appear in the search results table, set the applicable parameters in the 
search fields at the top of the page, and select Search.

Step 3 On the Edit User Basics page, on the Edit menu, select External Service Accounts.

Step 4 On the External Service Accounts page, select Add New.

Step 5 On the New External Service Accounts page, in the External Service field, select the display name that 
you entered in the “To Configure Cisco Unity Connection 8.0 for the Exchange 2003 Calendar and 
Contact Integration” procedure on page 34-13.

Step 6 In the Email Address field, enter the primary SMTP address in Active Directory for the user.

Step 7 In the Sign-In Type field, select the applicable option:

• Use Connection Alias—This option is useful when the User ID setting in Active Directory is the 
same as the Connection user alias. Connection signs in the user with the Connection user alias.

• Use User ID Provided Below—Enter the User ID setting from Active Directory (useful when the 
User ID setting is different from the Connection user alias). Connection signs in the user with the 
setting in this field.

Step 8 (Only when the Use User ID Provided Below option is selected in Step 7) In the User ID field, enter the 
User ID setting from Active Directory.

Step 9 Under Service Capabilities, check the User Access to Calendar and Personal Contacts check box.

Note A user can have only one external service that has the User Access to Calendar and Personal 
Contacts check box or the User Access to Calendar check box checked.

Step 10 Select Save.

Step 11 To check the calendar configuration for the user, select Test. The Task Execution Results window 
appears with the test results.

If any part of the test fails, verify the configuration for Exchange 2003, Cisco Unity Connection, and the 
user.

Step 12 Repeat Step 2 through Step 11 for all remaining users.

Testing the Exchange 2003 Calendar Integration in Cisco Unity Connection 8.0
Do the following procedure.
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To Test the Exchange 2003 Calendar Integration in Cisco Unity Connection 8.0

Step 1 Sign in to Outlook.

Step 2 On the Go menu, select Calendar.

Step 3 On the File menu, select New > Meeting Request.

Step 4 Enter values in the required fields to schedule a new meeting for the current time, and invite a user who 
has an account on Cisco Unity Connection.

Step 5 Select Send.

Step 6 Sign in to the Connection mailbox of the user that you invited to the Outlook meeting in Step 4.

Step 7 If the user account is configured for speech access, say Play Meetings.

If the user account is not configured for speech access, press 6, and then follow the prompts to list 
meetings.

Connection reads the information about the Exchange 2003 meeting.

Creating a Calendar and Contact Integration with Cisco Unified 
MeetingPlace in Cisco Unity Connection 8.0

If you have Cisco Unified MeetingPlace installed, you can integrate Cisco Unity Connection with Cisco 
Unified MeetingPlace so that users can review upcoming meetings and join active meetings by phone.

For information on configuring calendar and contact integrations in Cisco Unity Connection 8.5 and 
later, see the “Configuring Cisco Unity Connection 8.5 and Later and Microsoft Exchange for Unified 
Messaging” chapter and/or the “Configuring Cisco Unity Connection 8.5 and Later and Cisco Unified 
MeetingPlace for Unified Messaging” chapter of the Unified Messaging Guide for Cisco Unity 
Connection Release 8.5 and Later, available at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/unified_messaging/guide/85xcucum
gx.html.

Task List for Creating a Calendar Integration with Cisco Unified MeetingPlace 
in Cisco Unity Connection 8.0

1. Review the system requirements to confirm that all requirements for Cisco Unified MeetingPlace 
and the Cisco Unity Connection server have been met. See the “Requirements for the Cisco Unified 
MeetingPlace Calendar Integration in Cisco Unity Connection 8.0” section on page 34-17.

2. Configure Cisco Unified MeetingPlace. See the “Configuring Cisco Unified MeetingPlace for the 
Calendar Integration in Cisco Unity Connection 8.0” section on page 34-17.

3. Configure Connection. See the “Configuring Cisco Unity Connection 8.0 for the Cisco Unified 
MeetingPlace Calendar Integration” section on page 34-18.

4. Configure the Connection users. See the “Configuring Users for the Cisco Unified MeetingPlace 
Calendar Integration in Cisco Unity Connection 8.0” section on page 34-20.

5. Test the calendar integration. See the “Testing the Calendar Integration for the Cisco Unified 
MeetingPlace Calendar Integration in Cisco Unity Connection 8.0” section on page 34-21.
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6. To teach users how to list, join, and schedule meetings, see the “Cisco Unity Connection Phone 
Menus and Voice Commands” chapter of the User Guide for the Cisco Unity Connection Phone 
Interface (Release 8.x) at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/user/guide/phone/b_8xcucugpho
ne.html.

Requirements for the Cisco Unified MeetingPlace Calendar Integration in 
Cisco Unity Connection 8.0

The calendar integration with Cisco Unified MeetingPlace has the following requirements:

• Cisco Unified MeetingPlace as described in the “Requirements for Accessing Calendar Information 
for Meetings” section of System Requirements for Cisco Unity Connection Release 8.x at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/requirements/8xcucsysreqs.html
.

• Cisco Unity Connection installed as described in the Installation Guide for Cisco Unity Connection 
Release 8.x at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/installation/guide/8xcucigx.html
.

Configuring Cisco Unified MeetingPlace for the Calendar Integration in 
Cisco Unity Connection 8.0

Do the following procedure.

To Configure Cisco Unified MeetingPlace for the Calendar Integration in Cisco Unity Connection 8.0

Step 1 Sign in to the Cisco Unified MeetingPlace Application Server as an administrator.

Step 2 Select User Configuration > User Profiles.

Step 3 Select Add New.

Step 4 Enter the following values in the required fields to create a privileged service account:

First Name Leave this field blank.

Last Name Enter Cisco Unity Connection.

User ID Enter cucsvc or another user ID that you want.

User Password Enter the applicable password.

Profile Number Enter the applicable profile number.

Profile Password Enter the applicable profile password.

Type of User Select System Administrator.
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Note The values that you enter for the User ID, User Password, Profile Number, and Profile Password 
fields will be used in the “Configuring Cisco Unity Connection 8.0 for the Cisco Unified 
MeetingPlace Calendar Integration” section on page 34-18.

Step 5 Select Save.

Step 6 Sign out of Cisco Unified MeetingPlace.

Caution If you do not sign out of Cisco Unified MeetingPlace, the test will fail in the “To Test the Cisco 
Unified MeetingPlace Configuration for the Calendar Integration in Cisco Unity Connection 
8.0” procedure on page 34-18.

To Test the Cisco Unified MeetingPlace Configuration for the Calendar Integration in Cisco Unity Connection 8.0

Step 1 In the Address field of a web browser, if SSL is not enabled, enter the following URL (where <server> 
is the IP address or host name of the Cisco Unified MeetingPlace server):

http://<server>/webservices/services/meetingservice?wsdl

If SSL is enabled, enter the following URL:

https://<server>/webservices/services/meetingservice?wsdl

Step 2 Press Enter.

Step 3 When prompted to sign in, enter the user ID and password for the privileged service account that you 
created in the “To Configure Cisco Unified MeetingPlace for the Calendar Integration in Cisco Unity 
Connection 8.0” procedure on page 34-17.

The Cisco Unified MeetingPlace WSDL download page appears with the title “XFire Services.”

Configuring Cisco Unity Connection 8.0 for the Cisco Unified MeetingPlace 
Calendar Integration

Do the following procedure.

To Configure Cisco Unity Connection 8.0 for the Cisco Unified MeetingPlace Calendar Integration

Step 1 In Cisco Unity Connection Administration, expand System Settings, then select External Services.

Step 2 On the Search External Services page, select Add New.

Step 3 On the New External Service page, in the Type list, select MeetingPlace 7.0/8.0 External Service 
Template.

Step 4 Check the Enabled check box to enable the external service.

When this check box is not checked, the integration with Cisco Unified MeetingPlace is disabled.

Step 5 In the Display Name field, enter a descriptive name.
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Step 6 In the Server field, enter the IP address or host name for the Cisco Unified MeetingPlace server.

Step 7 In the Transfer Extension Dial String field, enter the digits that Connection must dial to transfer users 
on the phone to the opening greeting of Cisco Unified MeetingPlace server.

Step 8 In the Security Transport field, select the applicable setting:

• None—Connection does not use a secure connection with the Cisco Unified MeetingPlace server.

• SSL—Connection uses an SSL connection with the Cisco Unified MeetingPlace server.

Step 9 If you selected “SSL” and you want Connection to validate the Cisco Unified MeetingPlace server 
certificate, check the Validate Server Certificate check box.

Self-signed certificates cannot be validated. If you selected SSL and you are using self-signed 
certificates, do not check the Validate Server Certificate check box, or Connection will not be able to 
access Cisco Unified MeetingPlace. 

Caution The CN value on the server certificate subject line or the subjectAltName:dnsname field of 
the server certificate must match the setting of Server field. Otherwise, validation of the server 
certificate will fail.

The root certificate or all certificates in a root certificate chain of the Certification Authority 
(CA) that signed the server certificate must be installed as Connection-trust certificates in 
Cisco Unified Operating System Administration. Otherwise, validation of the server 
certificate will fail.

Step 10 In the Alias field, enter the alias for the privileged service account that Connection uses to sign in to the 
Cisco Unified MeetingPlace server.

This setting must match the User ID setting for the privileged service account that you configured in the 
“Configuring Cisco Unified MeetingPlace for the Calendar Integration in Cisco Unity Connection 8.0” 
section on page 34-17.

Step 11 In the Password field, enter the password for the privileged service account that Connection uses to sign 
in to the Cisco Unified MeetingPlace server.

This setting must match the User Password setting for the privileged service account that you configured 
in the “Configuring Cisco Unified MeetingPlace for the Calendar Integration in Cisco Unity Connection 
8.0” section on page 34-17.

Step 12 Under Service Capabilities, check the applicable check boxes:

• User Access to Calendar—Check this check box so that users can hear of their upcoming meetings 
by phone.

• MeetingPlace Scheduling and Joining—Check this check box so that users can schedule and join 
meetings.

Step 13 Select Save.

Step 14 To check the integration with Cisco Unified MeetingPlace, select Test. The Task Execution Results 
window appears with the test results.

If any part of the test fails, verify the configuration for Cisco Unified MeetingPlace and Cisco Unity 
Connection.
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Configuring Users for the Cisco Unified MeetingPlace Calendar Integration in 
Cisco Unity Connection 8.0

Do the following procedure.

Caution Cisco Unified MeetingPlace must have an end user for each Connection user that you are configuring.

To Configure Users for the Cisco Unified MeetingPlace Calendar Integration in Cisco Unity Connection 8.0

Step 1 In Cisco Unity Connection Administration, expand Users, then select Users.

Step 2 On the Search Users page, select the alias of a user.

Step 3 On the Edit User Basics page, on the Edit menu, select External Service Accounts.

Step 4 On the External Service Accounts page, select Add New. The New External Service Account page 
appears.

Step 5 In the External Service field, select the display name that you entered in the “Configuring Cisco Unity 
Connection 8.0 for the Cisco Unified MeetingPlace Calendar Integration” section on page 34-18.

Step 6 In the Sign-In Type field, select the applicable option:

• Use Connection Alias—This option is useful when the Cisco Unified MeetingPlace profile alias is 
the same as the Connection user alias. Connection signs in the user with the Connection user alias. 
Cisco Unified MeetingPlace provides information on public and private meetings to the user.

• Use Server Guest Account—Connection signs in the user as a guest, without using the Connection 
user alias or the User ID setting. Cisco Unified MeetingPlace provides information only on public 
meetings to the user.

• Use User ID Provided Below—Enter the profile alias from Cisco Unified MeetingPlace (useful 
when the Cisco Unified MeetingPlace profile alias is different from the Connection user alias). 
Connection signs in the user with the setting in this field. Cisco Unified MeetingPlace provides 
information on public and private meetings to the user.

Step 7 (Only when the Use User ID Provided Below option is selected in Step 6) In the User ID field, enter the 
User ID setting from Cisco Unified MeetingPlace.

Step 8 Under Service Capabilities, check the applicable check boxes:

• MeetingPlace Scheduling and Joining—Check this check box so that the user can schedule and 
join meetings.

• Primary Meeting Service—If the MeetingPlace Scheduling and Joining check box is checked for 
two or more external services, check this check box so that Cisco Unified MeetingPlace meetings 
will be set up through this Cisco Unified MeetingPlace server. Uncheck this check box so that Cisco 
Unified MeetingPlace meetings will be set up through another server.

Step 9 Select Save.

Step 10 To check the calendar configuration for the user, select Test. The Task Execution Results window 
appears with the test results.

If any part of the test fails, verify the configuration for Cisco Unified MeetingPlace, Cisco Unity 
Connection, and the user.

Step 11 Repeat Step 2 through Step 10 for all remaining users.
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Testing the Calendar Integration for the Cisco Unified MeetingPlace Calendar 
Integration in Cisco Unity Connection 8.0

Do the following procedure.

To Test the Configuration for the Cisco Unified MeetingPlace Calendar Integration in Cisco Unity Connection 8.0

Step 1 Sign in to Cisco Unified MeetingPlace as an end user.

Step 2 Select Schedule.

Step 3 Enter values in the required fields to schedule a new meeting for the current time, and invite a user who 
has an account on Cisco Unity Connection.

Step 4 Sign in to the Connection mailbox of the user that you invited to the Cisco Unified MeetingPlace meeting 
in Step 3.

Step 5 If the user account is configured for speech access, say Play Meetings.

If the user account is not configured for speech access, press 6, and then follow the prompts to list 
meetings.

Step 6 When you hear the system announce the Cisco Unified MeetingPlace meeting that you just scheduled, 
either say Join, or press the applicable keys on the phone keypad to join the meeting.

Creating a Calendar Integration with Cisco Unified 
MeetingPlace Express in Cisco Unity Connection 8.0

If you have Cisco Unified MeetingPlace Express installed, you can integrate Cisco Unity Connection 
with Cisco Unified MeetingPlace Express so that users can review upcoming meetings and join active 
meetings by phone or while using the Cisco Personal Communications Assistant (PCA).

Use the following task list to create a calendar integration.

For information on configuring calendar and contact integrations in Cisco Unity Connection 8.5 and 
later, see the “Configuring Cisco Unity Connection 8.5 and Later and Microsoft Exchange for Unified 
Messaging” chapter and/or the “Configuring Cisco Unity Connection 8.5 and Later and Cisco Unified 
MeetingPlace for Unified Messaging” chapter of the Unified Messaging Guide for Cisco Unity 
Connection Release 8.5 and Later, available at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/unified_messaging/guide/85xcucum
gx.html.

Task List for Creating a Calendar Integration with Cisco Unified MeetingPlace 
Express in Cisco Unity Connection 8.0

1. Review the system requirements to confirm that all requirements for Cisco Unified MeetingPlace 
Express and the Cisco Unity Connection server have been met. See the “Requirements for the Cisco 
Unified MeetingPlace Express Calendar Integration in Cisco Unity Connection 8.0” section on 
page 34-22.
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2. Configure Cisco Unified MeetingPlace Express. See the “Configuring Cisco Unified MeetingPlace 
Express for the Calendar Integration in Cisco Unity Connection 8.0” section on page 34-22.

3. Configure Connection. See the “Configuring Cisco Unity Connection 8.0 for the Cisco Unified 
MeetingPlace Express Calendar Integration” section on page 34-23.

4. Configure the Connection users. See the “Configuring Users for the Cisco Unified MeetingPlace 
Express Calendar Integration in Cisco Unity Connection 8.0” section on page 34-25.

5. Test the calendar integration. See the “Testing the Cisco Unified MeetingPlace Express Calendar 
Integration in Cisco Unity Connection 8.0” section on page 34-26.

6. To teach users how to list, join, and schedule meetings, see the “Cisco Unity Connection Phone 
Menus and Voice Commands” chapter of the User Guide for the Cisco Unity Connection Phone 
Interface (Release 8.x) at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/user/guide/phone/b_8xcucugpho
ne.html.

Requirements for the Cisco Unified MeetingPlace Express Calendar Integration 
in Cisco Unity Connection 8.0

The calendar integration with Cisco Unified MeetingPlace Express has the following requirements:

• Cisco Unified MeetingPlace Express as described in the “Requirements for Accessing Calendar 
Information for Meetings” section of System Requirements for Cisco Unity Connection Release 8.x 
at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/requirements/8xcucsysreqs.html
.

• Cisco Unity Connection installed as described in the Installation Guide for Cisco Unity Connection 
Release 8.x at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/installation/guide/8xcucigx.html
.

Configuring Cisco Unified MeetingPlace Express for the Calendar Integration in 
Cisco Unity Connection 8.0

Do the following procedure.

To Configure Cisco Unified MeetingPlace Express for the Calendar Integration in Cisco Unity Connection 8.0

Step 1 Sign in to Cisco Unified MeetingPlace Express and select Administration.

Step 2 Select User Configuration > User Profile Management.

Step 3 Select Add New.

Step 4 Enter the following values in the required fields to create an API user:

First Name Leave this field blank.

Last Name Enter Cisco Unity Connection.

User ID Enter cucsvc or another user ID that you want.
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Note The values that you enter for the User ID, User Password, and Profile Number fields will be used 
in the “Configuring Cisco Unity Connection 8.0 for the Cisco Unified MeetingPlace Express 
Calendar Integration” section on page 34-23.

Step 5 Select Save.

Step 6 Sign out of Cisco Unified MeetingPlace Express.

Caution If you do not sign out of Cisco Unified MeetingPlace Express, the test will fail in the “To Test 
the Cisco Unified MeetingPlace Express Configuration for the Calendar Integration in 
Cisco Unity Connection 8.0” procedure on page 34-23.

To Test the Cisco Unified MeetingPlace Express Configuration for the Calendar Integration in Cisco Unity 
Connection 8.0

Step 1 In the Address field of a web browser, if SSL is not enabled, enter the following URL (where <server> 
is the IP address or host name of the Cisco Unified MeetingPlace Express server):

http://<server>.com/webservices/services/meetingservice?wsdl

If SSL is enabled, enter the following URL:

https://<server>.com/webservices/services/meetingservice?wsdl

Step 2 Press Enter.

Step 3 When prompted to sign in, enter the user ID and password for the API user that you entered in the “To 
Configure Cisco Unified MeetingPlace Express for the Calendar Integration in Cisco Unity Connection 
8.0” procedure on page 34-22.

The Cisco Unified MeetingPlace Express WSDL download page appears with the title “XFire Services.”

Configuring Cisco Unity Connection 8.0 for the Cisco Unified MeetingPlace 
Express Calendar Integration

Do the following procedure.

To Configure Cisco Unity Connection 8.0 for the Cisco Unified MeetingPlace Express Calendar Integration

Step 1 In Cisco Unity Connection Administration, expand System Settings, then select External Services.

Step 2 On the Search External Services page, select Add New.

User Password Enter the applicable password.

Profile Number Enter the applicable profile number.

Type of User Select API User.
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Step 3 On the New External Service page, in the Type list, select MeetingPlace Express 2.0 External Service 
Template.

Step 4 Check the Enabled check box.

When this check box is not checked, the calendar integration with Cisco Unified MeetingPlace Express 
is disabled.

Step 5 In the Display Name field, enter a descriptive name. For example, enter “Cisco Unified MeetingPlace 
Express calendar.”

Step 6 In the Server field, enter the IP address or host name for the Cisco Unified MeetingPlace Express server.

Step 7 In the Transfer Extension Dial String field, enter the digits that Connection must dial to transfer users 
on the phone to the opening greeting of Cisco Unified MeetingPlace Express server.

Step 8 In the Security Transport field, select the applicable setting:

• None—Connection does not use a secure connection with the Cisco Unified MeetingPlace Express 
server.

• SSL—Connection uses an SSL connection with the Cisco Unified MeetingPlace Express server.

Step 9 If you selected “SSL” and you want Connection to validate the Cisco Unified MeetingPlace Express 
server certificate, check the Validate Server Certificate check box.

Self-signed certificates cannot be validated. If you selected SSL and you are using self-signed 
certificates, do not check the Validate Server Certificate check box, or Connection will not be able to 
access Cisco Unified MeetingPlace Express. 

Caution The CN value on the server certificate subject line or the subjectAltName:dnsname field of 
the server certificate must match the setting of Server field. Otherwise, validation of the server 
certificate will fail.

The root certificate or all certificates in a root certificate chain of the CA that signed the server 
certificate must be installed as Connection-trust certificates in Cisco Unified Operating 
System Administration. Otherwise, validation of the server certificate will fail.

Step 10 In the Alias field, enter the alias for the API user that Connection uses to sign in to the Cisco Unified 
MeetingPlace Express server.

This setting must match the User ID setting for the API user that you configured in the “Configuring 
Cisco Unified MeetingPlace Express for the Calendar Integration in Cisco Unity Connection 8.0” 
section on page 34-22.

Step 11 In the Password field, enter the password for the API user that Connection uses to sign in to the Cisco 
Unified MeetingPlace Express server.

This setting must match the User Password setting for the API user that you configured in the 
“Configuring Cisco Unified MeetingPlace Express for the Calendar Integration in Cisco Unity 
Connection 8.0” section on page 34-22.

Step 12 Under Service Capabilities, check the applicable check boxes:

• User Access to Calendar—Check this check box so that users can hear their upcoming meetings 
on the phone.

• MeetingPlace Scheduling and Joining—Check this check box so that users can schedule and join 
meetings.

Step 13 Select Save.
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Step 14 To check the integration with Cisco Unified MeetingPlace Express, select Test. The Task Execution 
Results window appears with the test results.

If any part of the test fails, verify the configuration for Cisco Unified MeetingPlace Express and 
Cisco Unity Connection.

Configuring Users for the Cisco Unified MeetingPlace Express Calendar 
Integration in Cisco Unity Connection 8.0

Do the following procedure.

Note Cisco Unified MeetingPlace Express must have an end user for each Connection user that you are 
configuring.

To Configure Users for the Cisco Unified MeetingPlace Express Calendar Integration in Cisco Unity Connection 8.0 

Step 1 In Cisco Unity Connection Administration, expand Users, then select Users.

Step 2 On the Search Users page, select the alias of a user.

Step 3 On the Edit User Basics page, on the Edit menu, select External Service Accounts.

Step 4 On the External Service Accounts page, select Add New. The New External Service Accounts page 
appears.

Step 5 In the External Service field, select the display name that you entered in the “Configuring Cisco Unity 
Connection 8.0 for the Cisco Unified MeetingPlace Express Calendar Integration” section on 
page 34-23.

Step 6 In the Sign-In Type field, select the applicable option:

• Use Connection Alias—This option is useful when the Cisco Unified MeetingPlace Express profile 
alias is the same as the Connection user alias. Connection signs in the user with the Connection user 
alias. Cisco Unified MeetingPlace Express provides information on public and private meetings to 
the user.

• Use Server Guest Account—Connection signs in the user as a guest, without using the Connection 
user alias or the User ID setting. Cisco Unified MeetingPlace Express provides information only on 
public meetings to the user.

• Use User ID Provided Below—Enter the profile alias from Cisco Unified MeetingPlace Express 
(useful when the Cisco Unified MeetingPlace Express profile alias is different from the Connection 
user alias). Connection signs in the user with the setting in this field. Cisco Unified MeetingPlace 
Express provides information on public and private meetings to the user.

Step 7 (Only when the Use User ID Provided Below option is selected in Step 6) In the User ID field, enter the 
User ID setting from Cisco Unified MeetingPlace Express.

Step 8 (Only if enabled) In the User Profile Number field, enter the User ID setting from Cisco Unified 
MeetingPlace Express. Connection signs in the user with the setting in this field.

Step 9 Under Service Capabilities, check the applicable check boxes:

• User Access to Calendar—Check this check box so that users can hear their upcoming meetings 
by phone.
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Note A user can have only one external service that has the User Access to Calendar and Personal 
Contacts check box or the User Access to Calendar check box checked.

• MeetingPlace Scheduling and Joining—Check this check box so that the user can schedule and 
join meetings.

• Primary Meeting Service—If the MeetingPlace Scheduling and Joining check box is checked for 
two or more external services, check this check box so that Cisco Unified MeetingPlace Express 
meetings will be set up through this Cisco Unified MeetingPlace Express server. Uncheck this check 
box so that Cisco Unified MeetingPlace Express meetings will be set up through another server.

Step 10 Select Save.

Step 11 To check the calendar configuration for the user, select Test. The Task Execution Results window 
appears with the test results.

If any part of the test fails, verify the configuration for Cisco Unified MeetingPlace Express, Cisco Unity 
Connection, and the user.

Step 12 Repeat Step 2 through Step 11 for all remaining users.

Testing the Cisco Unified MeetingPlace Express Calendar Integration in 
Cisco Unity Connection 8.0

Do the following procedure.

To Test the Cisco Unified MeetingPlace Express Calendar Integration in Cisco Unity Connection 8.0

Step 1 Sign in to Cisco Unified MeetingPlace Express as an end user.

Step 2 Select Schedule.

Step 3 Enter values in the required fields to schedule a new meeting for the current time, and invite a user who 
has an account on Cisco Unity Connection.

Step 4 Sign in to the Connection mailbox of the user that you invited to the Cisco Unified MeetingPlace Express 
meeting in Step 3.

Step 5 If the user account is configured for speech access, say Play Meetings.

If the user account is not configured for speech access, press 6, and then follow the prompts to list 
meetings.

Step 6 When you hear the system announce the Cisco Unified MeetingPlace Express meeting that you just 
scheduled, either say Join, or press the applicable keys on the phone keypad to join the meeting.
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